LINUX SOFTWARE ON A CHROMEBOOK
HOW TO RUN LINUX SOFTWARE ON A CHEAP CHROMEBOOK
WELCOME TO THE LATEST ISSUE OF FULL CIRCLE.

This month, we have no Python, but we do have Freeplane, Inkscape, and Great Cow Basic. In place of Python we have an interesting piece showing how you can run Linux software on your Google Chromebook.

SJ finishes his run of Researching With Linux this month with a discussion on installing CentOS. He’ll still be around though as he brings back his old Linux Loopback column.

UBports have released OTA-5 for Touch. OTA-4 was only released a short time ago, but they're hoping to get back to a regular release schedule now that they've done the hard work of upgrading the underlying Ubuntu that featured in Canonical’s Ubuntu Touch.

Our book review this month is on the Godot game engine. Erik (our resident cartoonist for The Daily Waddle) is hoping to start a series of articles showing you how to create your own simple games. Stay tuned for more info!

I won't hold you up any longer. Enjoy the issue, and (as ever) email me your thoughts on whatever you think regarding the magazine, Ubuntu, Linux or whatever. If I don't hear from you, I don't know if you're out there and/or enjoying the magazine. Hello? Anyone out there?

All the best, and keep in touch!
Ronnie
ronnie@fullcirclemagazine.org
DARPA INTRODUCES ‘THIRD WAVE’ OF ARTIFICIAL INTELLIGENCE

The Pentagon is launching a new artificial intelligence push it calls ‘AI Next’ which aims to improve the relationship between machines and humans.

As part of the multi-year initiative, the US Defense Advanced Research Projects Agency (DARPA) is set to invest more than $2bn in the programme.

In promo material for the programme, DARPA says AI Next will accelerate “the Third Wave” which enables machines to adapt to changing situations.

For instance, adaptive reasoning will enable computer algorithms to discern the difference between the use of ‘principal’ and ‘principle’ based on the analysis of surrounding words to help determine context.

DARPA defines the first wave of AI as enabling “reasoning over narrowly defined problems,” but with a poor level of certainty. The second wave, it claims, enables “creating statistical models and training them on big data,” albeit with minimal reasoning.

Moving away from scripted responses is the next aim for AI. A survey conducted at the Joint Multi-Conference on Human-Level Artificial Intelligence found that 37 percent of respondents believe human-like artificial intelligence will be achieved within five to 10 years.

AI Next will also involve DARPA’s Artificial Intelligence Exploration (AIE) programme announced back in July.

AIE is DARPA’s initiative for the development of AI concepts that it considers high-risk, but high-payoff. The aim is to establish the feasibility of such projects within a one-and-a-half year timescale.


SOLID: WEB INVENTOR LAUNCHES FREE WEB PLATFORM

No less a person than Tim Berners-Lee, who invented the World Wide Web (WWW) in the early 1990s and was ennobled for his services, is less than ever happy with the development the Web has taken. “I’ve always believed that the Web is there for everyone,” Berners-Lee writes. “But […] the Web has evolved into an engine of inequality and separation and is driven by powerful forces that only pursue their own goals.” What Berners-Lee means by that are corporations like Google, Facebook and Amazon, which collect, exploit and sell the data of the user to an unimaginable extent.

To counter this development, he now announces Solid. Solid is a...
NEWS

A platform that builds on the existing web. Solid is free software and is designed to manage and connect all the data a user wants to store in it in a novel way. In particular, all data remains private. On the platform run apps that the user selects. It also defines exactly which apps have access to which data. Data can be made available to other users so that collaboration is possible. While this is already possible in broad terms with platforms such as Owncloud and Nextcloud, in Solid the apps work much more together to provide the user with a greater benefit.

To enable Solid, Berners-Lee has taken leave from MIT and is returning to the World Wide Web Consortium (W3C). Together with John Bruce, an experienced manager, he founded the company Inrupt, which aims to create an ecosystem around Solid.

Solid is far from finished, but as with most open source projects, developers have decided to go public early. Solid is decentralized and in addition to public servers and private servers can be operated with solid. You can already get an identity and a pod (private data storage) and developers can start writing apps right now. More information can be found on the Solid website.

The Solid Server is an application for Node.js. He is under the MIT license and is developed on Github. Binary packages are available from the NPM website.

Source: https://www.pro-linux.de/news/1/26354/solid-webberfinder-startet-freie-web-plattform.html

ARCH LINUX'S OCTOBER 2018 ISO SNAPSHOT RELEASED WITH LINUX KERNEL 4.18.9

Arch Linux 2018.10.01 arrived today as the most up-to-date ISO image of the popular GNU/Linux distribution used by hundreds of thousands of users worldwide. It's powered by the Linux 4.18.9 kernel, though Linux kernel 4.18.10 is already in the stable repository, and the latest Linux 4.18.11 kernel is in the Testing one.

As expected, Arch Linux 2018.10.01 also includes all the latest software updates and security fixes that have been released via the main archives throughout September 2018. This means that you won't have to download hundreds of updates after installing Arch Linux on a new computer.

Arch Linux is a rolling operating system that follows a so-called rolling release model where the user installs once and receives updates forever, or at least until he does something that breaks the installation and needs to reinstall. This is where the monthly ISO snapshots come into play.

In other words, the Arch Linux 2018.10.01 is here only for new installation, for those who want to reinstall or deploy the GNU/Linux distribution on new computers without downloading hundreds of updates after the installation, except for those that are released since the ISO snapshot was built.


XCOM 2: WAR OF THE CHOSEN - TACTICAL LEGACY PACK IS COMING TO LINUX AND macOS

Good news for those who own the XCOM 2 turn-based tactics video game, as well as the XCOM 2: War of the Chosen expansion pack as Feral Interactive says that it plans to port the Tactical Legacy Pack DLC to Linux and macOS platforms soon after the October 9 release, which will only be available for Windows users at that time.

"The XCOM 2: War of the Chosen - Tactical Legacy Pack DLC includes a collection of new game modes, maps, weapons, armors and Photobooth options that honor the legacy of the XCOM series. It will launch for macOS and Linux shortly after the Windows release on 9th October," Feral Interactive wrote in today's announcement.

According to Feral Interactive, the XCOM 2: War of the Chosen - Tactical Legacy Pack DLC will be free to all owners of the XCOM 2:
NEWS

War of the Chosen expansion pack until December 3, 2018, at 11:59 pm EST. The Tactical Legacy Pack DLC will be available for grabs from Steam for Linux and Steam for macOS later this month.


MAJOR DEBIAN GNU/LINUX 9 "STRETCH" LINUX KERNEL PATCH FIXES 18 SECURITY FLAWS

Affecting the long-term supported Linux 4.9 kernel used by the Debian GNU/Linux 9 "Stretch" operating system series, there are a total of 18 security vulnerabilities patched in this major update that have been discovered in the upstream Linux kernel and may lead to information leaks, privilege escalation, or denial of service.

These include a memory leak in the irda_bind function and a flaw in the irda_setsockopt function of Linux kernel's IrDA subsystem, a flaw in the fd_locked_ioctl function in the Floppy driver, a buffer overflow in the Bluetooth HIDP implementation, and a double-realloc (double free) flaw in the rawmidi kernel driver.

Furthermore, a use-after-free bug and a potential null pointer dereference were discovered in Linux kernel's F2FS (Flash-Friendly File System) implementation, a potential null pointer dereference in the HFS+ implementation, and a stack-based buffer overflow flaw in the chap_server_compute_md5() function of the iSCSI target code.

The security patch also addresses a use-after-free bug was in Linux kernel's InfiniBand communication manager, and a variant of the Spectre V2 vulnerability dubbed SpectreRSB. Mitigations are also available for the Spectre Variant 2 flaw for some indirect function calls used in paravirtualised guests.

Security flaws were also discovered in the HID events interface in debugfs, the Cipso IPv4 module, the Linux kernel exit code used on 64-bit (amd64) systems running as Xen PV guests, the yurex driver, the cdrom driver, and a use-after-free flaw in the vmacache_flush_all function.


MANJARO 18 NEARLY HERE AS LOTS OF TESTING UPDATES PUSHED THIS WEEK

The Manjaro Linux developers have been hard at work these past couple weeks, as a steady stream of testing updates have become available on average every couple of days. Manjaro Linux is an Arch-Linux based distro that has seen quite a huge surge in popularity this past year, as it focuses on overall user-friendliness and working ‘straight out of the box’.

The great thing about Manjaro is that its basically Arch Linux without all of the difficulty in actually installing Arch. Arch is a fantastic distro that typically has the latest in Linux technology, but its really a headache to get up and running, since you need to install the base system and then all the packages you want.

The recent slew of updates is all leading up to the anticipated Manjaro-Illlyria 18.0 release, which is expected to be available in late October. Of course, there is currently a beta version available (Manjaro-Xfce 18.0), which includes the latest xfce-gtk3 packages, and the latest UI enhancements.

The Manjaro developers are also working on a new hardware project, called the Bladebook Fall 2018 – it will be running Manjaro KDE v18.0 preinstalled, with the Intel Apollo Lake Quad-Core HD APU, a fanless metal material, and utilize eMMC as its primary storage, although the dev states that additional M2-SSD could be possible.

Source: https://appuals.com/manjaro-18-nearly-here-as-lots-of-testing-updates-pushed-this-week/
The second patch is regarding the CoC enforcement. At the moment, the code mentions that all the instances of abusing, harassment, and unacceptable behavior may be reported to Technical Advisory Board (TAB); the complaints will be reviewed, and TAB will maintain confidentiality regarding the reporter.

James has proposed that since the actual enforcement process is yet to be determined, the TAB clause should be dropped until the community decides something concrete.

The Linux kernel 4.19 release is expected to arrive after two weeks.

Source: https://fossbytes.com/linux-code-of-conduct-changes-before-4-19-release/

**Mageia 6.1 Linux Distribution Now Available**

While many people are familiar with popular Linux distributions like Ubuntu, Fedora, and Mint, there are far more open source operating systems available. There are probably too many, but I digress. Please know, just because a distro isn't very well known, doesn't mean it's bad.

One such quality Linux distro that isn't super popular is Mageia. It is a fork of the once wildly popular Mandriva operating system. Today, Mageia 6.1 becomes available for download. It features LTS Linux kernel 4.14 and updated Nvidia drivers.

"This release brings all of the updates and development that has gone into Mageia 6 together into fresh installation media, giving users a kernel that supports hardware released after Mageia 6. The new installations will benefit from the countless updates that currently fully updated Mageia systems will have, allowing new installations to avoid the need for a large update post install," says Donald Stewart, Mageia.

Stewart further says, "...if you are currently running an up to date Mageia 6 system, there is no need to reinstall Mageia 6.1 as you will already be running the same packages. This release is available with only Live media, i.e. Live Plasma, Live GNOME and Live XFce in 64bits, and Live XFce in 32 bits. A network installation is also available, for users wanting more granular control over the installation."

Source: https://betanews.com/2018/10/06/mageia-linux-61/

**Gentoo-Based Calculate Linux 18 Released with Linux Kernel 4.18, Faster Boot**

Coming ten months after Calculate Linux 17.12 New Year’s Eve release, Calculate Linux 18 brings faster boot times to the live ISO images, ports all the in-house built Calculate Utilities to the latest QtS application framework, adds a new way for managing network connections, and updates most of the core components and apps.

Among the new features included in Calculate Linux 18, we can mention easier installation of Virtual Private Server (VPS) and
Emmabuntüs Debian Edition 2 has been updated over the weekend to version 1.03, which is now available for download. It's a bugfix release based on the latest Debian GNU/Linux 9.5 "Stretch" operating system and featuring a mix of performance improvements, software updates, and cosmetic enhancements.

Highlights of Emmabuntüs Debian Edition 2 1.03 include the ability to execute post-install scripts without the root password, new and more compact post-installation dialog windows, a new welcome dialog, support for Flatpak apps, a script to optimize the Swap usage, a script for installing the Steam for Linux client, shortcuts to user folders, and automatic swap activation in live mode.

Emmabuntüs Debian Edition 2 1.03 ships with Mozilla Firefox 60.2, Skype 8.26, HPLip 3.18.6, and TurboPrint 2.46. It also adds the PDF-Shuffler and Gscan2pdf apps, a screen lock app for the LXDE desktop environment, Bluetooth activation management, and support for mounting hard disk drives or internal partitions without the root password. The Emmabuntüs Wiki was updated as well.

Other than that, this release improves the desktop integration and the wallpaper management when starting Xfce, fixes various issues with the WhiskerMenu application launcher, Thunar shortcuts, Chromium icon, the links to the user directory in Cairo-Dock configuration files, as well as the ability to launch binaries in sbin. It also removes FBReader and replaces PyRenamer with ThunarBulkRename.


KDE Plasma 5.14 Released: What’s New in the Popular Linux Desktop

Plasma is one of the most popular Linux desktop environments around; it’s loved by new open source enthusiasts and veterans alike. To bring a fresh and updated experience to the users, the KDE Project keeps bringing newer versions of the Plasma desktop from time to time.

The latest Plasma release 5.14.0 has just been pushed and it brings obvious bug fixes and new features. So, let’s tell you about them in brief.

For Plasma 5.14, the developers have worked a lot to improve Discover — Plasma’s software manager and add-on installer. With the new fwupd support, you can now use it to update your PC’s firmware.

The other features of Discover include the support for Snap channels, sorting of apps by release date, better stability, etc.

Plasma 5.14 also brings improvements and new effects to the KWin window manager. As a result, you can find the animations smoother and better.

Source: https://fossbytes.com/kde-plasma-5-14-release-linux-new-features/
BPFTTRACE SHOULD BECOME DTRACE SUCCESSOR FOR LINUX

Earlier this year, it became known that the original Dtrace analysis tool created by Sun - thanks to a license change by the owner Oracle - could also come on Linux. Long-time former Sun and Oracle employee Brendan Gregg, who now works at Netflix, points out in his blog the release of Bpfttrace, which he calls "Dtrace 2.0".

The now available application Bpfttrace describes Gregg as a kind of better successor to Dtrace. The new software not only has more capabilities than Dtrace, but has also been built from the ground up with modern techniques such as the eBPF-VM. EBPF is an almost universally applicable virtual machine (VM) in the Linux kernel itself, which emerged from the Berkeley Packet Filter (BPF).

The work on eBPF and techniques based on it has been done for several years, also with the collaboration of the developer Gregg. In addition to the VM, for example, the BPF compiler collection (BCC) with associated run-time libraries is being created, which, among other things, should allow porting of Dtrace tools. Bpfttrace is a "complementary extension" that offers "a high-level language for one-line and short scripts".

Bpfttrace has progressed so far that all Gregg's Dtrace in-line machines now work with the new application, which the developer calls a "milestone". In addition Gregg counts on his blog still some further functions, which would like to implement the Bpfttrace involved team still, as well as numerous further details to the technology.


PUNKT: A MINIMALIST ANDROID FOR THE PARANOID

Readers cry out for more diversity in the phone world, but few alternatives are as striking as Punkt's take on Android.

Petter Neby, founder and CEO of the Swiss design-led company, told The Register Punkt's second device is coming to market this year with an unusual USP - security hardening by BlackBerry.

The eye-catching MP02 closely resembles the first 2G device, designed by Jasper Morrison, whose work spans light rail vehicles to furniture. But it's the first built on a Google-free AOSP Android code base to support 4G. Neither Punkt phone is cheap - the MP02 retails at $350.

And it resolutely won't do WhatsApp.

To enterprise to C-suite types, Punkt opted to be the first non-BlackBerry-branded ODM to use the BlackBerry-hardened manufacturing process. BlackBerry Secure Integrated Manufacturing Service (BSIMS) involves injecting cryptographic keys at manufacturing, the process monitored remotely from BlackBerry HQ in Waterloo, Canada.

BlackBerry is well out of the phone handset business, but back in the day it gave each device a unique crypto identifier, and a few years ago acquired Certicom. BSIMS is an attempt to turn a process into a service for third parties.

In the three years since the Priv launched, BlackBerry has yet to see it rooted. BlackBerry wants IoT device manufacturers to adopt this as a quality mark. With so much insecure home tat flying in from China, consumers and industrial buyers need all the help they can get.

Source: https://www.theregister.co.uk/2018/10/09/punkt_mp02/

MICROSOFT: WE'VE GOT YOUR BACK, LINUX, HERE ARE 60,000 PATENTS TO PROTECT YOU

Microsoft loves Linux. And it really wants to prove it. In lieu of a wedding ring, the company has decided to show its dedication to open-source software by joining the Open
Innovation Network (OIN), a community designed to protect Linux and other open-source software from legal liability.

As part of its grand gesture, the company is also planning on making 60,000 of its patents public, and making them available to the OIN. This should help protect Linux from legal liability, and make those patents available for use by the 2,400 members of the OIN free of charge.

Those 60,000 patents do cover a large part of Microsoft’s war chest, but there will still be some exceptions. Windows desktop and desktop application code, for example, won’t make the cut - for obvious reasons. But the decision does mark a new era for Microsoft, in which it may have more open-source in its DNA than ever before. It also represents a huge blow to Microsoft’s bottom line, as patent royalties from Android smartphone makers made Microsoft billions of dollars each year.

Source: https://www.neowin.net/news/microsoft-weve-got-your-back-linux-here-are-60000-patents-to-protect-you/

**Linux Smartphone Librem 5 Will Ship With GNOME 3.32**

Last month, Purism announced that its Librem 5 Linux smartphone will ship in April 2019; earlier, it was scheduled to arrive in January 2019.

It seems that the developers will now get sufficient time to ship their phone with GNOME 3.32. In a blog post, the project urged the app developers to “use libhandy 0.4.4 and up, use GTK+ 3.24.1 and up and target GNOME 3.32!”

With the help of the new features added to libhandy and GTK+ fixes, developers can make their apps adaptive to both desktop and GNOME-running Librem 5 mobile device.

The post also mentions that many applications like Calls, Chatty, Fractal, and Podcasts are already using such adaptive capabilities; similar work is also being done for Settings, Games, Contacts, and Geary.

Currently, a GTK+ 3 widget library, libhandy and relevant widgets will be soon ported to GTK+ 4.

Source: https://fossbytes.com/linux-smartphone-librem-5-will-ship-with-gnome-3-32/

**Ubuntu Touch OTA-5 Is Out for Ubuntu Phones with New Morph Browser, Improvements**

With the Ubuntu Touch OTA-4 finally rebasing the mobile OS on the Ubuntu 16.04 LTS (Xenial Xerus) operating system series, the UBports team can now concentrate their efforts on bringing more new features and improvements, which will land in the upcoming Ubuntu Touch OTA-5 release.

Highlights of the Ubuntu Touch OTA-5 release include a new Morph Browser to replace the old Oxide Browser, which is based on a more recent version of the Chromium engine, new scaling features to display content at appropriate sizes on various devices, including phones and tablets, as well as to
display websites the way they are designed.

Ubuntu Touch OTA-5 also brings support for KDE's Kirigami 2 QtQuick controls for mobile devices, which let application developers manipulate and draw various visual parts of apps, to offer better integration of Plasma Mobile apps in Ubuntu Touch, as well as a bunch of new wallpapers, ringtones, and notification tones to replace the old ones.

Ubuntu Phone users using the OTA-4 release can now update their devices to the OTA-5 update via System Settings > Updates. After installing, your Ubuntu Touch device will be rebooted automatically for the OTA-5 update to be installed correctly. Ubuntu Touch OTA-3 or older users can also update to Ubuntu Touch OTA-5, which will guide them to setup their devices for the new Ubuntu 16.04 base.


**Google Ponders the Shortcomings of Machine Learning**

Critics of the current mode of artificial intelligence technology have grown louder in the last couple of years, and this week, Google, one of the biggest commercial beneficiaries of the current vogue, offered a response, if, perhaps, not an answer, to the critics.

In a paper published by the Google Brain and the Deep Mind units of Google, researchers address shortcomings of the field and offer some techniques they hope will bring machine learning farther along the path to what would be "artificial general intelligence," something more like human reasoning.

The research acknowledges that current "deep learning" approaches to AI have failed to achieve the ability to even approach human cognitive skills. Without dumping all that's been achieved with things such as "convolutional neural networks," or CNNs, the shining success of machine learning, they propose ways to impart broader reasoning skills.

The paper, "Relational inductive biases, deep learning, and graph networks," posted on the arXiv pre-print service, is authored by Peter W. Battaglia of Google's DeepMind unit, along with colleagues from Google Brain, MIT, and the University of Edinburgh. It proposes the use of network "graphs" as a means to better generalize from one instance of a problem to another.

However, "many defining characteristics of human intelligence, which developed under much different pressures, remain out of reach for current approaches," especially "generalizing beyond one's experiences."

Hence, "A vast gap between human and machine intelligence remains, especially with respect to efficient, generalizable learning."

In response, they argue for "blending powerful deep learning approaches with structured representations," and their solution is something called a "graph network." These are models of collections of objects, or entities, whose relationships are explicitly mapped out as "edges" connecting the objects.

Source: https://www.zdnet.com/article/google-ponders-the-shortcomings-of-machine-learning/

**Richard Stallman Announces “GNU Kind Communication Guidelines”**

It seems that the GNU Project isn't unaffected from the development happenings in the land of Linux. After Linux kernel community introduced its Code of Conduct to make the contributors and maintainers follow certain rules and make the community more welcoming to the new contributors, Richard Stallman said that strict of conduct are "repressive and rigid."

In the latest development, he has announced “GNU Kind Communications Guidelines.” The initial version of the guidelines is
available online and Stallman has requested the GNU contributors to follow them.

In his announcement post, Stallman talks about the ongoing discussion regarding GNU development pushing away new contributors, specially women.

Comparing it to Linux’s new Code of Conduct, Stallman calls them different on the fundamental level — while Code of Conduct punishes those who violate it, GNU Kind Communication Guidelines tries to help people learn how to communicate with kindness.

Source: https://fossbytes.com/richard-stallman-gnu-kind-communication-guidelines/

**KDE Plasma 5.14.2 Desktop Environment Improves Firmware Updates, Snap Support**

Coming just one week after the first point release, the KDE Plasma 5.14.2 point release is here with yet another layer of improvements and bug fixes to make the KDE Plasma 5.14 desktop environment more stable and reliable. Highlights of this second point release include firmware updates improvements and better Snap support in the Plasma Discover software manager.

KDE Plasma 5.14.2 also adds accessibility information to desktop icons, addresses a typo in the GTK theme treeview style for the Breeze GTK theme, lowers the Qt dependency for plasma-browser-integration to version 5.9, improves focus handling in Plasma Desktop, and updates Plasma Networkmanager (plasma-nm) to display the right current download and upload speed.

Among some other noteworthy changes included in the KDE Plasma 5.14.2 point release, we can mention a fix for a bug discovered in Plasma Workspace, which made Plasmashell freeze when attempting to get information about free space from mounted remote filesystems after losing the network connection to it, and better compatibility with Firefox 58 and later for the bookmarks runner.


**Want To Run Linux On Android Without Rooting? Using UserLAND**

Just recently I came across a new app on Google Play Store that can help you run Linux on your existing Android smartphone. Named UserLAND, this application is fully open source, and its code is available on GitHub.

The latest 1.0.0 version of the app follows the last beta release 0.5.3, which was under development for the past few months. So, let’s tell you what the free UserLAND app has to offer.

You must be knowing that Android is based on a modified Linux kernel. So, it makes sense that you can use Android to run Linux commands and use tools like ssh? UserLAND makes these things easier and lets you run Linux distros like Debian and Ubuntu.

The major highlight of this app is that it doesn’t demand root access from you. It’s a big relief as rooting also exposes one’s device to numerous security flaws and warranty hazards. You can use it to install/uninstall apps like any other regular application.

To use the app, you can use either run single-click apps or make use of user-defined custom sessions. The second method involves defining the filesystem and services (vnc or ssh) you wish to use. After this, the app downloads the necessary files, sets up everything, and connects to the server.

Source: https://fossbytes.com/userland-linux-apps-distros-on-android-no-rooting/

**Linus Torvalds Discusses His Return To Linux Development**

Following the release of Linux kernel 4.19, the 4.20 (or 5.0)
“If real issues do come up in the future, we will address them then, as we always have the option to change and revisit things as needed,” he added.

Source: https://fossbytes.com/linux-torvalds-return-to-linux-development/

**PINEPHONE: PINE64 IS MAKING AN AFFORDABLE LINUX SMARTPHONE RUNNING KDE PLASMA**

Following the demise of Ubuntu Phone, Purism’s Librem 5 seems like the next big thing in the budding world of Linux smartphones. Purism has already partnered with big names like GNOME and KDE, and we can expect the device to start shipping in April 2019.

It seems like another hardware vendor is looking to develop its own Linux smartphone. As reported by it’s FOSS, Pine64 is working to create inexpensive Linux-based smartphones and tablets.

KDE Neon creator Jonathan Riddell revealed this at Open Source Summit, Europe Edition. Upon contacting Pine64 founder TL Lim, it’s FOSS found that the devices are called PinePhone and PineTab — so, no surprises there.

Starting November 1, Pine64 will start shipping the first PinePhone developer kits to the selected devs for free. The kit will include baseboard, SOPine module, 7” Touch Screen Display, Camera, Wifi/BT, Playbox enclosure, Lithium-Ion battery case, and LTE cat 4 USB dongle.

As per the current schedule, Plasma Mobile-running PinePhone’s actual design won’t be finalized until 2019 Q2.

As Pine64 is known for its low-cost laptops, PinePhone won’t break your backbone when it comes to pricing. You can expect this open source Linux smartphone to cost $100+ for 2GB RAM and 16GB storage variant.

Source: https://fossbytes.com/pinephone-pine64-affordable-linux-smartphone-kde-plasma/
The last month has been spent once again updating my CV. I do this quite frequently in order to keep it up-to-date as possible when it comes to my skills and experiences. That way, if someone asks for my CV, I’ll have something to send them quickly. The problem with this is that the CV I update is massive (to contain all the possible information), and I always need to copy-and-paste sections into a tailored CV for whichever position I want to apply to. This is tedious and error-prone - I’d much prefer a DRY (don’t repeat yourself) method so I need to update my information in only one spot. Enter LaTeX.

**What is LaTeX?**

LaTeX is a markup language that is very popular with the math and science fields, due to its ability to easily represent mathematical equations. For the use case we’re covering in this article, however, we’re mainly focused on the ability to define your own reusable snippets.

**Example?**

I decided on this approach while looking at various CV templates in LaTeX. In the Further Reading section, you’ll find a link to the selection of templates I ultimately chose (specifically, the sidebar one). As such, instead of creating a placeholder CV for this article, I will instead refer to the examples in that repository.

**Getting Started**

What you’ll need to do is install LaTeX. My recommendation is to install Texmaker (an editor for LaTeX) and let it pull down the dependencies. This will take a while, as the files are quite large.

Next, you’ll want to create a nice folder to place your files in. This is the folder that will contain your .tex file, as well as the resulting PDF files and any temporary or supplementary files you may need (i.e. pictures). I therefore recommend that you use a new, empty folder for this.

Once you’re done with the preliminaries, I’d also recommend finding a nice template that appeals to you, and download an example into this new folder to work with. Since everyone may be working with a different template, I will try to keep the instructions generalized so anyone can follow along.

**Housekeeping**

Once you’ve downloaded your template, you may discover that there are multiple files, or that there is one single large file. If there is only one file, you’ll want to split it up as I outline below. If the template is already segmented in a similar manner, jump onto the next section.

- Check for the start of the file (defined with \begin{document}). Everything before this should be moved into a separate file (called, for example, preamble.tex)
- Once the preamble.tex file is created, you’ll want to import it back into the original file. To do this, place \input{preamble} at the start of the file (before \begin{document}). The reason for this is simple - now you can guarantee a shared library of functions and styling that you can re-use in multiple CVs.

  - If you want to clean up preamble.tex by inserting or removing comments for better legibility (or perhaps to make space for your future additions), do that now.

  - I’d also recommend setting the correct paper type (such as a4 [a4paper] or letter [letterpaper]) in the \documentclass definition.

**Creating custom commands**

Once you’ve created your preamble.tex file, you should compile the main template file. This is to make sure that it still works correctly, and to get an idea of how your information will be styled/placed on the page.
Typically, there will be a few guaranteed sections to a CV: Skills, Experience, Education, and contact information. If you need another section (or your template has an area for something else), then the approach will be the same.

**SKILLS**

The template I used indicates the skills using some sort of icon and label in a list in the sidebar. Depending on your template, you may need to adjust the actual code. I recommend copying the existing example data while creating your new command.

The snippet below can now be called anywhere that imports preamble.tex with \webSkills. If I need to make a change, I can simply make the changes in the preamble and then recompile the actual CV I need updated. Depending on how finely you need to divide the information up, you could create commands for common groups or even for individual skills so you can mix and match in the CV file. Be careful you don’t slice it up so much that you’re essentially still writing an entire CV every time.

```
\newcommand{\myEducation}{
  \cevent{3000-3004}{Bachelor of Science (Honours) Flying Cars}{University of Mars}{Bachelor project: Creating a perpetual fuel starship for interstellar travel.}
  \cevent{2995-2999}{Intergalactic Baccalaureate}{Intergalactic School Station of Neptune}{Member of the Young Space Rangers}
}
```

```
\newcommand{\webSkills}{
  \textcolor{white}{
    \icontext{Code}{12}{JavaScript}{white} \[6pt]
    \icontext{Code}{12}{Meteor}{white} \[6pt]
    \icontext{Code}{12}{Ruby/Ruby on Rails}{white} \[6pt]
    \icontext{Code}{12}{Python}{white} \[6pt]
    \icontext{Code}{12}{PHP}{white} \[6pt]
    \icontext{Code}{12}{Go}{white} \[6pt]
    \icontext{PaintBrush}{12}{CSS}{white} \[6pt]
    \icontext{PaintBrush}{12}{HTML}{white} \[6pt]
    \icontext{Database}{12}{MongoDB}{white} \[6pt]
    \icontext{Database}{12}{SQL}{white} \[6pt]
    \icontext{CodeFork}{12}{Git}{white} \[6pt]
  }
}
```

**EDUCATION**

This is the last specific code I’ll be sharing. The other areas can be done in the exact same method. The reason I cover education as well is because I call more complicated custom commands within \myEducation. The details have been fictionalized for the sake of this article (why they ended up so sci-fi, I don’t know!).

You can also include formatting in these custom commands, though I would only do so if you’re pretty certain they won’t change. Otherwise, you’ll want to style them in the individual CVs.

**CALLING CUSTOM COMMANDS**

Calling these commands are pretty simple. A barebones example would be:

```
\input{preamble}
\begin{document}
\myEducation
\webSkills
\end{document}
```

Naturally, you’ll want to format and place the information in the relevant sections of the template. The upside to the template is that you will be given styling information you can tweak, instead of creating all of this from scratch.

**CONCLUSION**

Hopefully this article will help others who, like me, want to keep a running database of skills for their CV that they can reuse. If you know of templates for LaTeX that you enjoy using (or have created), feel free to send me a link. If you have questions, comments, or suggestions, I can be reached at
**The Official Full Circle App for Ubuntu Touch**

Brian Douglass has created a fantastic app for Ubports Touch devices that will allow you to view current issues, and back issues, and to download and view them on your Ubuntu Touch phone/tablet.

**Install**

Either search for 'full circle' in the Open Store and click install, or view the URL below on your device and click install to be taken to the store page.

https://uappexplorer.com/app/fullcircle.bhdouglass

Lucas has learned all he knows from repeatedly breaking his system, then having no other option but to discover how to fix it. You can email Lucas at: lswest34@gmail.com.
Three days ago, my HP Chromebook 11 G5 acquired the ability to load Linux apps when Chromeos was updated to Version 70.0.3524.2 (Official Build) dev (64-bit).

Since then, I have been busy learning how to implement this.

It is rather exciting - given my past experience with this machine and the decision to remove Developer Mode because of security considerations. Developer Mode and Crouton had allowed me to run Chromeos and UbuntuMate at the same time, but made the machine much less secure than one running Chromeos normally.

It is now possible to create a Crostini VM and Linux container very easily, and there is no security compromise when starting the machine.

A few Googles on the internet quickly resolved what was needed to initiate the VM and container - see below.

Following this advice, I was able to use crosh to open a container, run xclock and Visual Studio Code.

Initially having opened a crosh window [Ctrl + Alt + t], I typed:

```
vmc start dev
```

and was rewarded with - (termina)

```
chronos@localhost ~ $
```

This indicates that you have a functional VM. You have to wait a while for the VM to download.

Next, you need to

```
run_container.sh -- container_name=stretch -- user=rob -- shell
```

but substitute your user name for 'rob'.

This downloads a Debian Stretch image and takes quite a bit
of time unless you have masses of bandwidth.

Once the required files have been downloaded

rob@stretch ~ $

appears.

Using Terminal which appears in a Linux app group after the VM is downloaded is much easier because you don’t have to supply ‘run_container.sh – container_name=stretch -- user=rob --shell’ - each time you initiate the container after starting the VM. Clicking on the Terminal app starts both VM and container.

My standard Linux load is nano, wget, Gimp, Inkscape, Scribus, Stellarium, Sublime Text and Visual Studio Code. When you load Gimp, you end up with ImageMagick as well.

Although I loaded Chromium yesterday, and used it to access Dataplicity for upload and download of files through Nextcloud on my RASPI, this is not necessary.

When Terminal is working properly, it is possible to upload and download files through the Chromeos Files Linux (Beta) folder.

Have now removed Chromium.

Have worked on files in Gimp, Inkscape and Scribus, and moved them between Linux and Chromeos.

This HP Chromebook 11 G5 - with 4 MB RAM and a 16 GB drive, is a bit lacking in space for Linux.

4 MB RAM & a 32 GB SSD/emmc would be better. A touch screen for the grandchildren and Storytime would be nice too!

Now have icons for Gimp, Inkscape, Scribus, Stellarium, Sublime Text, Terminal and Visual Studio Code as a Linux group on the shelf.

The Google team appear to have done a brilliant job of integrating Linux with Chromeos, given their system security guidelines.

They are keen to make Linux tools, editors and IDEs available to Chromebook users, especially developers.

In addition to Sublime Text and Visual Studio Code, have loaded Atom, Bluefish and Brackets - all of which work normally. Atom, Brackets and Visual Studio Code need additional repositories to be added. Hence the need for wget.

References:

From scratch to VS Code _ Crostini.mhtml, Crostini 101 _ Crostini.mhtml and What Linux apps on Chrome OS means for open source - TechRepublic.mhtml.
When building a map, I often find it useful to tag or mark a node. This is especially helpful when my map is about a project or a group of projects. Freeplane's attributes feature does the trick as it lets you create a property/value pair. Freeplane keeps track of these attributes and the values you assign to them. You can even lock the list of possible values for certain attributes. In this article, I will explore the use of attributes.

**Adding and Editing Attributes**

There are several methods for adding and editing attributes. The most useful being Edit > Node extensions > Edit attribute in-line. You can also find Edit attribute in-line in the right-click menu. Lastly, you can use the shortcut keys ALT + F9. If the selected node doesn’t have any attributes, Freeplane adds a blank pair. The left blank is for the attribute, and the right blank is for the value. You can type in a new attribute name or use the dropdown arrow to select an existing one. You can type in a value in the right blank or press the ENTER key to get a dropdown list. The list includes values already assigned to the attribute.

If there are attributes assigned to the selected node, you can use the arrow keys to move around in the table. You can change the attribute by using the dropdown list or by typing a new attribute name. When editing the value, you press the ENTER key to get a dropdown list of assigned values, or type in a new value.

If you right-click in the table, you get a context menu. ‘Optimal width’ scales the width of the table columns to fit the longest text in the column. ‘New attribute’ creates a row for you to add an attribute to the node. ‘Delete’ removes the selected attribute from the node. Up and Down moves you up and down the rows of attributes. (You can do the same things with the up and down arrow keys.) If you right-click on a value in the table, you get a context menu that includes the ability to add hyperlinks. You can add a link by choosing the file or typing in the URL/path. You can add a link to a node, too. You can use the mailto method as outlined in Part 8.

Press the ESC (Escape) key to exit the edit mode or select a different node.

When you add an attribute to a node, the menus View > Node attributes determine whether it shows. ‘Show selected attributes’ will display only the attributes tagged as selected. Later, I will show you how to set the select tag. To display all attributes below the node, select ‘Show all attributes’. ‘Hide all attributes’ will show no attributes. Use the Show icon for attributes to display the attributes icon on the node core. If you hover over a node with attributes, all the attributes will show in a pop-up.

Another way to add attributes is through a dialog. Use the menus Edit > Node extensions > Add attribute in dialog. The dialog has two dropdown lists and two buttons. From the Attribute Name...
There are four columns across the top of the dialog: Attributes, Selected Visible, Restricted Set, and Edit. The Attribute column lists the active attributes in the map. You can check the Selected Visible column to change how the attribute shows in the node. If checked, the attribute will display below the node. If unchecked, the attribute shows only when you hover over the node. This is dependant on the attribute’s view settings. Restricted Set locks the values for that attribute to those already in the map. Use the Edit button to change the list of values.

The Edit dialog has a list of the current values, a text box, and buttons to add, rename, and delete. To add a value, type the new value in the text box and click the Add button. To rename a value select the value to change, make the change, and click the Rename button. You delete a value by selecting the value and clicking the Delete button. Click the Close button to return to the Attribute Manager dialog.

Four buttons line the bottom of the Attribute Manager dialog. The OK button saves your changes and closes the dialog. Click the Apply button to save your settings without closing the dialog. The Cancel button closes the dialog and discards any changes. The Import Map button opens a dialog that allows you to import attributes and values from any open maps. Select the attributes and values you want to import and click the OK button. Click the Cancel button to close the dialog without importing any attributes.

The first entry in the manager is All Attributes. This entry is used to make changes related to all attribute names. The other rows allow you to edit values of specific attributes. Checking the Selected Visible makes all attributes visible under the node. Unchecking makes all the attributes show only when the mouse hovers over a node. The Restricted Set locks the addition of any attributes except in the manager. The Edit lets you add and remove attributes from the current map. It works the same as the values dialog, but you are adding and removing attributes instead of values.
**Find and Replace Attribute**

In the menus, Edit > Node extensions > Find and replace attribute brings up the Extended attribute editor. The two radio buttons at the top determine the nodes affected by your search and replace queries. You can pick from Selected nodes and All visible nodes. The checkbox Skip root node determines whether to include the root node in the search. Two sets of combo boxes allow you to select or enter attribute/value pairs. The Add button applies the top attribute pair to the indicated nodes. To remove a certain attribute from the node, select it in the top pair and click Remove all values button. The Remove this value button will remove only the attribute/value from the top pair. The Replace with button will replace the top pair with the bottom pair. The Close button closes the dialog.

**Attribute From Style**

In the style editor, you can add attributes to a style. When you assign a node to the style, the attributes aren't added to the node. You apply the style attributes through the menus Edit > Node extensions > Attribute from style. This assumes the node is assigned to a style and the style has attributes. In the style editor, you find the attribute options in the Edit > Node extensions menu. Remove Attributes

In the menus, Edit > Node extensions > Remove attributes, you have options to Remove first, Remove last, and Remove all attributes.

**Tool Panel**

In the Tool Panel on the Calendar and Attributes tab, you find one more place to add attributes to nodes. But in the panel, you get a feature not found elsewhere, the ability to format the values of the attributes.

The attribute section is at the bottom of the tab. The New attribute button adds an attribute to the selected node. The Optimal width works in the same way as it does in other places. The Value format will open a list of formats. You will recognize many of these from the article on core text formatting (Part 8). Select a format to apply to the attribute value. The format is applied only to the currently selected value.

The right-click menus are the same as those when editing the attributes in-line.

**Filtering and searching nodes by attributes**

In the filter toolbar or the filter composer, the attribute names display in the left-hand dropdown list. The right-hand dropdown list is available for selecting defined values. Select the comparison operator from the middle dropdown list. All comparison operations consider the data type of the values (text, date, time, number). The status bar shows the type of the selected value.

Attributes are a great way to tag and identify nodes for a certain purpose. You can add attributes in-line or through the Attribute manager. In the Tool Panel, you have an option to format the values on the Calendar and Attributes tab.

Elmer Perry is a technical support rep for an international keyless access company. He enjoys writing, woodworking, and technology. He lives in Leicester, NC with his wife.
In FCM#136, I showed you how to use the analog to digital conversion (ADC) with a light-dependent resistor (LDR) to gather information about the ambient brightness and how to communicate to a remote device at distance.

The reception with the standard receiver was bad, so I did some research, and ordered another receiver-module to improve the reception, it is called "RXB8 V2.0" and came at a reasonable price. In this issue we will enhance the Radio Frequency (RF) device interface to save some power - to do this I will introduce the Watchdog timer.

**INTRODUCING THE WATCHDOG TIMER**

Imagine a situation where you program a microcontroller for a critical system. You would not just rely on the reliability of the software to avoid damage, would you?

Software can always contain bugs, or maybe some environmental conditions arise that you did not think of in the first place. So, it would be important to restart the microcontroller to its initial state if something goes wrong. In such situations you surely will use the watchdog timer, which can restart the microcontroller completely. With respect to low resources, another use case of the watchdog timer would be to implement a power saving mode to save battery life. The device drains as little battery as possible (while sleeping) and can then use the watchdog timer to wake up. So how does the watchdog timer (WDT) work internally?

The watchdog timer has a separate on-chip oscillator working at 128 KHz which works as a overflow timer. Thru a prescaler, you can set the time when the overflow occurs. The WDT can operate in three modes: interrupt, system reset or interrupt and system reset:
- The interrupt mode can be used
to wake up the device, or to
timeout operations that last too long.
- The system reset mode is quite self-explanatory, the device is restarted without further notice and all volatile data is erased.
- The remaining mode combines the aforementioned ones, the
interrupt occurs and you can implement a routine where you
save your data or send some debugging information (eg, over
the UART), and then the system is reset.

The WDT can be activated in two ways:
- By setting a hardware fuse (WDTON): in this mode the WDT is
set to ‘system reset’ mode and cannot be changed or switched off by software on the fly. Only the
overflow of the WDT can be prevented by resetting it.

<table>
<thead>
<tr>
<th>WDP3</th>
<th>WDP2</th>
<th>WDP1</th>
<th>WDPO</th>
<th>Oscillator (Cycles)</th>
<th>Overflow time</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>8192</td>
<td>64 ms</td>
</tr>
<tr>
<td>1</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>1048576</td>
<td>8.0 s</td>
</tr>
<tr>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
</tr>
</tbody>
</table>

- The WDT can be activated by software: then all three modes can be used. For the ATTiny13a, different timings can be set (to trigger overflow). For this article we need to know only two timing options.

**LED FLASHER WITH THE WATCHDOG TIMER**

The WDT needs a timed sequence, without interruptions, to be changed or switched on and off:
- First, make sure thatInterrupts are off.
- Reset the WDT.
- The watchdog change register (WDTCR) must be set to logic 1 in the watchdog change enable bit (WDCE).
- Enable the watchdog and set the prescaler of the watchdog timer.
HOWTO - GREAT COW BASIC

Compile the code shown right and upload it to the ATTiny13a, connect a LED to PortB.1, and see what happens.

The program starts, the LED is turned on and activates the WDT. After 64 ms the microcontroller restarts.

The ‘boot time’ by default is about 64 ms according to the factory default. In this setup, the microcontroller is just reset - no power-save mode is used just yet. The LED flashes relatively fast because of the short time the LED is set to on (64 ms).

POWERSAVE MODES

The ATTiny13a has three different power-save modes, each of them with more or less power consumption. In sequence by power-consumption (from highest to lowest) they are: Idle, ADC Noise Reduction and Power-down. The choice depends on the situation, and what you want to achieve with your device. For now, we’ll use power-down mode. The other sleep modes will be explained in a further article, when they are needed. To get an idea how low the power consumption can be, have a look at the site of Nick Gammon (Ref. No. 5), he did some measures for us.

ENERGY EFFICIENT TRANSMITTER

Let’s extend the code from the last issue and use the power-save mode, and the watchdog timer to pause the transmission. The microcontroller takes around 64 ms to start, then we set the watchdog timer. After this, the program sends the LDR values over the air. The transmission itself now takes around 48 ms. The former version of the program waits 8 s without doing anything – but still consumes power!

Here (next page, shown right) is how we optimize this by using the power-down sleep mode, and the watchdog timer.

On the first start after the microcontroller gets power, the microcontroller is initialised. Then the watchdog timer is set to the reset mode, and the main program measures the LDR and sends the data over the transmitter. Then all of the Timer and the ADC get switched off, and the sleep mode power-down is enabled. After that the microcontroller is sent to sleep. After 8 seconds it gets a restart, and so the same procedure gets repeated every 8 second.

Here is the logged data from the serial line, with the new receiver in place, and the new
software version on the microcontroller. The result (next page, top right) is good (see time 00:13:01 for the first dataset and 00:13:09 for the second dataset, as highlighted in black).

Only a minimum of garbage is received, so a data logging program could easily pick up the lines with the wanted data and safely omit the unwanted bytes.

BREADBOARD CIRCUITRY

The transmitter part is exactly the same as in the last issue, so I omit depicting it here again. The transmitter has two extra PINS to connect (than the former device):

On the left side, there is a connector for the antenna (a wire ~ 17 cm is sufficient) and GND. On the right side, there are GND, DATA and Vcc (+5V). Both GND can be
connected with a Y-wire to the same GND. The DATA pin goes to the Rx-Connector of the serial-to-usb-converter. Due to the shape of the new transmitter, I hooked up jumper wires to the connectors and let it rest on a safe area on my workplace. Maybe not what a serious electrician would do, but it worked just fine.

CONCLUSION

The initial simple receiver module I got (without too deep research on the subject) did its job for our first experiments, but the replacement I found is better. So, if you are about to buy the hardware, I recommend the receiver-modules (FS-1000A) from the last issue and the receiver-module (RXB8, v2) from this one. However, I highly recommend to do your own research; there are maybe better modules for both purposes.

The newer program saves power, and, because some lines of code have been saved too, it has a little extra free space on the microcontroller for further optimisation and other ideas. For the next issue, I plan to prepare a little data logger program on the PC side, and expand the transmitter software to send data in larger time frames, and to gather some real life values.

SOURCES

If you want to download the sources instead of copy-pasting it, you can now check it out with git or an SVN client. Have a look at goo.gl/aDvggr for more information.

REFERENCES

The AVR watchdog timer explained http://microchipdeveloper.com/8avr:avrdt


Fuses calculator with comprehensive information on the devices factory defaults http://www.engbedded.com/fusecalc/

Inspiration for the simple startcode https://sourceforge.net/p/gcbasic/discussion/579126/thread/f48c95af/


ACKNOWLEDGEMENT

I wish to thank Evan Venn (Anobium) from the Great Cow BASIC Team for his insights and valuable hints.

Boris holds a bachelor degree in business administration and works for an insurance company. While not working, he is a family person and enjoys playing with his kids or tinkering with his personal projects. Contact info and additional material at his site: https://www.evil-publishing.de/fcm
A quick summary: over the past few instalments, we’ve looked at a couple of animation techniques for SVG files. First was to use the animation capabilities of CSS, which has better support across browsers but is limited to animating those properties that can be exposed via CSS (i.e. the ones that will work in the “style” attribute). This covers a lot of possibilities, but does not include many of the core attributes that are found in SVG elements, such as their coordinates or path definitions. For some cases – such as transforms – enough of SVG’s capabilities have been added to CSS for such restrictions to be nothing more than an annoyance that can be worked around. For others, however, CSS simply isn’t up to the task.

That’s where SMIL comes in. It’s an older specification for animation, created around the same time as the original SVG specs, and does provide the ability to animate arbitrary attributes in SVG. It can animate the “d” attribute that makes up the shape of a path, for example – a task that can only otherwise be accomplished in the browser via JavaScript. But although SMIL is more powerful than CSS in this regard, it has never been adopted in any Microsoft browser, leading to its inexorable decline and a likely deprecation in the browsers that do support it.

Given this situation, we won’t look any further at SMIL, but there are still a few tricks that can be performed with CSS that are worthy of further investigation. This time, we’re going to look at an increasingly popular animation technique which is really the result of taking a simple feature of SVG and pushing it in ways it wasn’t really intended for. It’s commonly referred to as “line animation”, although the line itself doesn’t change shape (remember, that can’t be done with CSS yet). It’s also sometimes referred to as a “self-drawing” image, which is a bit more descriptive: this technique results in a path that appears to be drawn on the screen in the same way as you would draw it with a pen.

The first thing we’ll need is a path to animate. It should not have a fill, but will require a stroke. For this demonstration I’ve used Inkscape’s star tool to create an eight pointed star, then converted it to a path and roughly moved every second point inwards to give more of a cartoon gunshot appearance. I’ve given it a stroke-width of 2px and saved it using the “Optimised SVG” option in order to strip out most of the excess baggage from the file, just so that this tutorial isn’t filled with several pages of code.

Opening the file in a text editor reveals a structure like that shown below.

As you can see, it’s a pretty simple file. Even the `<g>` isn’t really needed, but it’s easier to leave it in place with its own transform, rather than try to manipulate the coordinates of the path to compensate for its removal.

The secret to this animation technique is in the fact that SVG has a nice, simple, CSS-animatable way of drawing dashed and dotted strokes, rather than solid ones. The next step, therefore, is to introduce some dashes, defined in CSS. Note that you’ll probably have
to also remove the corresponding properties from the path’s “style” attribute if you saved as a normal Inkscape file.

Save the file (top right) and load it directly into a web browser, and you should see something like this:

The values we set in the stroke-dasharray property are used to determine the lengths of the drawn segments and gaps along the path. With our value of “10 2 3 5” the stroke will be drawn as a line segment of 10 units, followed by a gap of 2 units, then another line of 3 units and a gap of 5 units. The sequence then automatically repeats, so the next line segment is 10 units long and the next gap is 2. It runs around the path uninterrupted by corners, so a line segment (or gap) of 10 might appear as 3 units on one side of a corner and 7 on the other – look at the leftmost corner of the shape for a good example of this. If you follow the line round, taking that into account, you can see that the stroke dashes do follow the pattern we’ve set.

This automatic repeating of values in the stroke-dasharray property produces a couple of neat features. The first is that any odd number of entries is effectively the same as writing a value that is twice as long, with the line and gap values swapped in the second half. So a value of “10 5 10” is the same as writing “10 5 10 5 10” – in other words a long line, short gap, long line then a long gap, short line, long gap. Notice that the length of the lines in the first half make up the length of the gaps in the second, and vice versa.

The other feature – and the one we’re interested in here – is that you can collapse the value down to a single number to get equal line and gap lengths. A lone value of “10” expands to “10 10”, giving you a repeating series of lines that are 10 units long, followed by gaps that are 10 units long. In my example file, that gives you something like this:

Now consider what happens if we increase the value. As the number goes up, so the visible line segments get longer – but so do the gaps. Below is a sequence of screenshots of the same image with the stroke-dasharray value set to 10, 20, 50, 100 and 500.

By the time we get to 500 our first visible line segment almost covers the entire path. If we were to continue increasing the value until it is the same as the path length, it would effectively render it the same as if we didn’t have the stroke-dasharray at all. And that’s exactly what we want to do!
In practice this means that setting a positive value here will “swallow” that much of the start of the stroke array, whereas a negative value will “push” the stroke array further along the path.

By adjusting the value of stroke-dashoffset we can “slide” the drawn portion of the stroke along the path. Here’s what it looks like with values of 0px, 100px, 200px, 300px. Notice that progressively larger numbers swallow more of the path, showing more of the gap at the end.

As you know, setting the dasharray to the same value as the length of the path will draw the entire path. But also setting the dashoffset to that value will then swallow the drawn segment, leaving only the gap (which is also the length of the path). In other words, our path will disappear completely.

With the drawn segment completely swallowed, we’re at the starting point for our animation: our path is not visible on the screen. By decreasing the dashoffset value we can make the drawn segment creep onto the screen, following the shape of the path. All we need to do, therefore, is to animate the stroke-dashoffset value (see part 75 if you need a reminder of the animation syntax):

Reload the file in your browser and you should see the effect we’re looking for – and because it’s all just CSS animation embedded directly in the SVG file, it will even work when the file is pulled into a web page via an <img> tag.

Just a minute! Where did that value of 575 for the dasharray and dashoffset come from? As you’ve probably realised, that’s the total length of my path. You could theoretically get it from Inkscape via the Extensions > Visualise Path > Measure Path… extension, but that throws a Python error on my system. Alternatively you could just use trial and error: increasing the value of the dasharray until it just fills the path (which is quite...
easily done using the browser developer tools, if you’re familiar with them).

The simplest option, though, is to ask the browser to do the hard work for you by invoking a little JavaScript. There is a method on the <path> object called getTotalLength() which will return the calculated length of the path. You can call it via the developer console in the browser, or modify your <svg> element to call the method when the file loads and display the value on screen. Here’s an example that will work for a file with a single path:

Remember that JavaScript won’t run when the document is loaded via the <img> tag, so to use the getTotalLength() method you will have to load the SVG file directly into the browser. You only need to do it once, then you can simply hard-code the value into the <style> block and remove the JavaScript code entirely.

There is also an alternative to specifying the actual length of the path. You could add a “pathLength” attribute to the path, set it to a value of your choosing, then treat that value as the total length in the CSS. This basically tells the browser “I want to pretend this path is 100 units long, even though we both know it’s not, so can you just do the maths for me as needed”. A good compromise is to use JavaScript to find the actual length, then round it to the next whole number and set that value in the pathLength attribute and the CSS. That way any browser that understands pathLength will use it to give you a precise animation, and those that don’t are still using a value that’s close enough to work in most cases.

There’s one final thing to note with this approach. So far I’ve used the version of the technique you’ll most commonly find documented online, but, according to SVG expert Amelia Bellamy-Royds, the definition of stroke-dashoffset in the specification is vague enough that not all browsers behave identically. She suggests an alternative of forgetting dashoffset entirely and just animating stroke-dasharray instead. In this case, you need to include two numbers in the property as you need both the line and the gap to change together. My animation code then becomes:

```html
<svg xmlns="http://www.w3.org/2000/svg"
    onload="alert(document.querySelector('path').getTotalLength());">
  ...
</svg>

<style>
  path {
    stroke-dasharray: 0 575;
    animation-name: drawPath;
    animation-duration: 5s;
    animation-fill-mode: both;
  }

  @keyframes drawPath {
    100% { stroke-dasharray: 575 0; }
  }
</style>
```

If you want to play around with this effect, but have the computer do a little more of the hard work for you, a discussion of this technique over on inkscapeforum.com led to one user creating an Inkscape extension that will add the CSS animation code for you. You can find the extension at https://gitlab.com/Moini/ink_line_animator/ and follow the original thread at http://www.inkscapeforum.com/viewtopic.php?f=5&t=33721

Just animating a star being drawn is a little dull, but does show you the basic approach. Although the star contains no curves, this method works equally well with any shape of path. An easy step on from this, for example, would be to replace the star with a path for some handwritten text, to produce a “self-writing” effect. Be aware, however, that sharp transitions can cause rendering artefacts depending on the miter limit. In the case of my star, for example, the corner at the start/end of the line flashes on and off as the rest of the line is drawn. It’s often better to use rounded corners and that shown below.
end caps to avoid this, which also helps to reinforce the illusion of the line being drawn by a pen or pencil.

If you’re prepared to spend more time hand-crafting your animations there’s no reason why you shouldn’t produce a self-drawing SVG image consisting of multiple paths, each animated separately using delays to ensure that they appear in the correct order. Once your outline is drawn, some more delayed animations could fade in the fill colours, erase some of the lines, or cross-fade to a raster image. With time and effort, this technique can produce some spectacular results, and all just by moving a dashed line around.

Mark uses Inkscape to create three webcomics, ‘The Greys’, ‘Monsters, Inked’ and ‘Elvie’, which can all be found at [http://www.peppertop.com/](http://www.peppertop.com/)
CentOS is the main backbone for servers in corporations. However, you can install a Gnome or KDE desktop environment for use as a workstation with a few packages. It is not suggested for new Linux users, just for experienced users. So why did I choose this OS?

It has a 10-year LTS cycle. It is backed by Red Hat. A strong online volunteer community. It is rock solid and stable on the 3.18 Linux kernel. Yet the software apps are mature and not bleeding edge. There are plenty of online tutorials describing the installation, secondary software repositories, and updating the system. I choose the Gnome DE since I am well versed in it.

The hardest problem I found running CentOS is installing an image editor. After reading the online forums and wiki, I installed kdenlive. Libreoffice 5, VLC, Firefox, and the other main software staples are installed by default. I then installed PHP and R from the command-line, and uploaded my respective batch files for data processing.

So how do I use the software apps in research? I use kdenlive to edit class tutorials. I use VLC to change the media files to different formats as needed for websites. Firefox for personal interbrowsing. Libreoffice for manipulating data sets in CSV files. GIMP and Inkscape for scientific posters and research volunteer study recruitment. Rstudio to process unique data sets for low back pain and shoulder pain studies.

There are other aspects that I wished I could expand upon, but those uses are not published in journals for consumption by the general public. Once these are published, I am at liberty to divulge our use. So why do I use Linux in research?

The Linux OS is portable and is free of proprietary licenses, so any researcher can use code or devices, without having to contact Microsoft or Apple. Plus the free and open software status allows more money to be dedicated to the actual grant for better research methods. Linux is an international community that allows research, corporations, and people to excel.

SJ Webb is a researcher coordinator. When he is not working, he enjoys time with his wife and kids. He thanks Mike Ferarri for his mentorship.
Right on the heels of UBport’s OTA-4 release comes the official 16.04 version of Ubuntu Touch for mobile devices. This will be the fifth Over The Air update (OTA-5), and it will also be the first of many updates that now adhere to a regular release roadmap.

While many have already joined the community on 16.04 with OTA-4, in addition to the long-term support of upstream Ubuntu development, OTA-5 will include a more stable experience, new tweaks, and new features to show off this next stage of Ubuntu Touch development.

UPGRADING TO OTA-5 AND WHAT TO EXPECT

Devices running Ubuntu Touch on all UBports channels will receive the OTA-5 update. You will be able to update via System Settings -> Updates.

After installing, the device will reboot, and you will be in OTA-5. That’s it!

If you are upgrading from 15.04 (OTA-3 or older) then you will be greeted by a walk-through to ensure that your devices are set up to work with 16.04.

NEW FEATURES

Morph Browser

The old Oxide web engine "Browser" app is being replaced by our new QtWebEngine browser, Morph (formerly known as browser-ng). "Morphing" the browser to QtWebEngine means that the code will have upstream benefits from the Qt company, and it uses a more recent version of the Chromium engine as its base. This should resolve a number of browser issues, and make use of new scaling features.

Morph Browser takes advantage of Qt Automatic Scaling (see below), so that the websites you visit look the way that they are supposed to no matter what form factor you are using.

Qt Automatic Scaling

Since Ubuntu Touch currently runs on both mobile phones and tablets (and possibly more devices down the road) it’s important that things display at appropriate sizes. Qt Automatic Scaling will allow developers to write apps using the Qt Quick Controls 2 and they will display at an optimal size for the form factor. Kirigami 2 widgets will also be able to take advantage of this feature.

Kirigami 2 (KDE widgets)

Kirigami 2 is a set of QtQuick controls for mobile. It is a set of components that allow developers to manipulate and draw various overlays, themes/icons, and other visual parts of apps. Use of this toolkit will increase the chances of sharing of apps between Ubuntu Touch and Plasma Mobile.

COMMUNITY ART

We held a Community Showcase in celebration of our journey toward this major release. Many people responded and submitted amazing artwork and audio creations. These wallpapers, notification tones, and ringtones will be included in the OTA-5 image and will replace some of the older defaults. As is always possible in UT, of course, you have the ability to add your own custom wallpapers and tones to expand it as an extension of who you are.
I don’t always use the internet, but when I do, eyebrows....
This is my old Acer Aspire 5570-2609 (actually a 5570z) laptop with a T2060 1.6 GHz CPU, 14.1 inch screen – that now sports 2 GB RAM and a 300 GB Hard Drive. This originally came with 1 GB RAM and an 80 GB Hard Drive. I just bought an adapter for the DVD drive to install a 2nd HDD. With SSD prices dropping daily, I plan to move my current 300 GB HDD into that adapter and install the SSD into the original HDD caddy.

Why am I even bothering with this old laptop today? I got the new 2nd Hard Drive holder for only $11 NEW, and that, along with the drop in SSDs, make it now a good addition for relatively cheap. Also, the reason for my falling back to using this old laptop is that MSI has so far taken 4 1/2 months to honor their so-called defective warranty. To date, I have received my so-called repaired MSI motherboard back twice, with my motherboard being in worse shape than when I sent it to them for defective replacement. It seems that MSI thinks that a 3-year warranty allows them to take up to 3 years to get it working again. I am a small-time computer builder/repairman, and the way MSI is handling my defective motherboard has influenced my spending habits with MSI. Not only my spending habits, but other builders I know have sworn off MSI products too. Word of mouth has influenced their circle of friends too, which influences their circle...

We have to honor defective items to our customers, and MSI shows they will not, which tells us that when an MSI product goes defective, then it will be us paying for a replacement. Just keep that in mind when you buy any MSI products. Just because one of MSI’s products is defective does not mean you will get a new or even working refurbished replacement. For me, so far, 4 1/2 months have passed with me bouncing between one computer and another – just to bide time with the hopes my motherboard is repaired or the price refunded. I’d rather have the price refunded, just so I no longer have to play MSI’s games any longer.

I even got the dreaded Wi-Fi to work, and it actually worked better in Ubuntu than Vista’s Wi-Fi programs. I have finally gotten to the point that, once Ubuntu Studio 18.10 is released, then I will make the total switch away from Microsoft concerning my "i5-7400 desktop build." Why? I do not do anything illegal, but I am tired of Microsoft stealing my private and personal information. I’ve even started using DuckDuckGo because it does not track you the way Google does. I also use the much better Opera VPN, along with the VPN leak prevention extension. Those two Opera extensions have positive, heavy duty, results when compared to Firefox, Chrome, Internet Explorer, and Edge browsers. I have also recently started to use the much-maligned TOR browser – just to maintain my privacy even further, and it works for "most" of my needs. Since using Opera with VPN extensions, and now also using TOR browser, my spam emails have dropped to almost nothing - zero. I’ve also quit receiving daily telephone calls from advertisers/scammers. I do not think my almost non-existent spam emails and no telephone calls are just coincidence.
GUIDELINES

The single rule for an article is that it must somehow be linked to Ubuntu or one of the many derivatives of Ubuntu (Kubuntu, Xubuntu, Lubuntu, etc).

RULES

- There is no word limit for articles, but be advised that long articles may be split across several issues.
- Write your article in whichever software you choose, I would recommend LibreOffice, but most importantly - PLEASE SPELL AND GRAMMAR CHECK IT!
- In your article, please indicate where you would like a particular image to be placed by indicating the image name in a new paragraph or by embedding the image in the ODT (Open Office) document.

- Images should be JPG, no wider than 800 pixels, and use low compression.
- Do not use tables or any type of bold or italic formatting.

If you are writing a review, please follow these guidelines:

- When you are ready to submit your article please email it to: articles@fullcerclemagazine.org

TRANSLATIONS

If you would like to translate Full Circle into your native language please send an email to ronnie@fullcerclemagazine.org and we will either put you in touch with an existing team, or give you access to the raw text to translate from. With a completed PDF, you will be able to upload your file to the main Full Circle site.

REVIEWS

GAMES/APPLICATIONS

When reviewing games/applications please state clearly:

- title of the game
- who makes the game
- is it free, or a paid download?
- where to get it from (give download/homepage URL)
- is it Linux native, or did you use Wine?
- your marks out of five
- a summary with positive and negative points

HARDWARE

When reviewing hardware please state clearly:

- make and model of the hardware
- what category would you put this hardware into?
- any glitches that you may have had while using the hardware?
- easy to get the hardware working in Linux?
- did you have to use Windows drivers?
- marks out of five
- a summary with positive and negative points

You don't need to be an expert to write an article - write about the games, applications and hardware that you use every day.
Godot Engine Game Development

I was really looking forward to this book. I skipped straight to page 39, What is Godot? I glued my eyes to my screen - as I got the electronic version and did not look up until my eyes were well and truly tired. This book should be your companion if you are new to Godot.

The explanations are clear, and there are illustrations on almost all the topics. (When I say illustrations, I mean clear screenshots of where you should be working.)

After a well-written introduction into the Godot Interface, we are taken to the first project, 'coin dash'. We are told NOT to skip this chapter. In this chapter, some of the explanations answered quite a few of my questions regarding Godot and GDscript. The chapter is broken into five parts, each dealing with a part of the game. You learn as you go along and end up with a silly game and much clearer understanding of the Godot engine.

The second project is 'escape the maze'. This introduces us to things like layers and enemies and a few more nodes. Now not broken up into parts any more but continuing with what you have learned.

Each successive project makes use of more of the engine until the last project 3D mini golf, where you get a gentle introduction into 3D. You get to use everything you learned in 2D plus things like 3D cameras. A small chapter at the end titled "Additional topics" touches on things like shaders. Do not expect a book for Unity developers; this book is squarely aimed at the beginner and does so very well. The book feels personal. Throughout the chapters, I felt as if the Author was talking to me alone.

After books like "SAMS teach yourself Godot Engine Game Development in 24hrs" - that was written by a team of people - with more projects, this book is a breath of fresh air. The book also has a very familiar feel, as if I have read it before, but somewhere else, about something else. I may be imagining this or it may be the way the book was structured. Each successive project builds on the others and at no point do you feel lost. It is also easy to go back and look up something you have forgotten.

This book, however, does not dive into topics like networking, but I promise you will have as much fun as I had making my "own" games in Godot. I felt like a kid who could not wait to try something new. This book is a great starter to your Godot journey and I can freely recommend it.

Four stars - and that's only because I wanted more on GDscript. (Since I am not a programmer, the "man" pages do not make a world of sense in Godot.)
FULL CIRCLE 2018 SURVEY

It's that time of the year again where we ask what you think of FCM, Ubuntu, and Linux.

Some questions are a requirement, some you can skip over if not applicable.

Your answers will help shape Full Circle, so please use your constructive criticism. If you don't tell us what you think, or what we're doing wrong, then we won't know.


FULL CIRCLE NEEDS YOU!

Without reader input Full Circle would be an empty PDF file (which I don't think many people would find particularly interesting). We are always looking for articles, reviews, anything! Even small things like letters and desktop screens help fill the magazine.

See the article Writing for Full Circle in this issue to read our basic guidelines.

Have a look at the last page of any issue to get the details of where to send your contributions.
Welcome again to another issue of FCM! In this section we will endeavour to answer your questions. Be sure to add details of the version of your operating system and your hardware.

I will try to remove any personally identifiable strings from questions, but it is best not to include things like serial numbers, UUID’s or IP addresses.

Because of the possibility of bad English, spelling, and grammar, I will correct these for Q&A. It just reads better for our readers, and is not intended to change your questions in any way. If you are not sure about you spelling, etc, you can run your question through Google translate.

Years ago, I had an end user come into the OEM I was working for and walk up to the workshop counter. As my technicians were busy helping offload the container with our stock, I went over to the "customer". As we mainly dealt with resellers, and I was sure I knew them all, I approached this person carefully. After the pleasantries were out of the way, the person put a stiffy disk (1.44 MB) on the counter, and asked if I could load the internet on it for them.

I do not know if I kept a straight face, but I tried really hard!

Q: I am getting an error in dmesg readout: BUG: soft lockup - CPU#1 stuck for 23s! BUG: soft lockup - CPU#2 stuck for 23s! BUG: soft lockup - CPU#3 stuck for 23s! BUG: soft lockup - CPU#4 stuck for 23s! What can this be?

A: In my experience, that usually means you have a hardware error or misconfigured BIOS. You did not say if this error is coming up and the system works fine, or the error prevents you from using your computer. If it is preventing you from using your computer, then, go into the BIOS, do a BIOS reset to defaults, and turn off things you do not use, like floppy drive controllers and serial ports. If it is a desktop, look for bubbling capacitors on the main board (and have them replaced) and try another power supply.

Q: I would appreciate your advice regarding how to work around a Ubuntu 16.04.5 problem. The desktop icons got too large after I updated from 16.04.1. These icons are >1" in size and are too large for my laptop screen. I tried to shrink them down, but the methods that I tried, without success, include the following:

• Resize icons to the minimum by right-clicking on them.
• Use Dash/Files, select the second icon at the upper right corner, then use the slide bar to reduce the icons to the minimum possible size.
• Hold down the Control Key and rotate the mouse wheel forwards/backwards.

Please advise. Thank you in advance.

A: There are many ways to skin a cat, but first note that the desktop environment matters, as well as the icon theme. I am going to assume Gnome – as you did not specify a desktop environment. The desktop icons shrink and grow in Gnome when you resize them in Nautilus. Know however, there is also a minimum and a maximum setting. 33% in 16.04, if I remember correctly. In Ubuntu 16.04, CCSM (Compiz Config Settings Manager) is also still an option, so is dconf-editor if you do not mind getting your hands dirty. "org/gnome/nautilus/icon_view". You can also use gconf-editor. You can even go to "preferences" in file explorer (Nautilus) and change the default zoom level. Please also know that the minimum size, hardcoded into Gnome is 48px. ---- however ----

This problem has taken me on another journey; I cannot reproduce the "large" error, however I find that my testing on 4 PC’s produced the opposite: no matter how I changed my Nautilus icons, my desktop icons would remain 48px. I suspect we need to log a bug report.
Q: How do I install a .run file. I am used to windows, but new to Linux.

A: Linux file permissions are not the same as you were used to on windows. The ".run" part is for you, not the computer. The file will work even without the extension. To execute a file in Linux, you have to assign it 'execute' permissions. Right-click on the file and go to properties. Select the permissions tab and tick the checkbox marked "Allow executing file as program". Welcome to the world of freedom!

Q: I want to minimize all my windows to the taskbar like I do in windows, but I don’t know how to add it to the dash. I run Ubuntu 18.04.1, with standard install, on an Acer Travelmate with 4 GB memory.

A: There is none that I am aware of. I replaced my dash with Plank, and that has the option to add a "show desktop" icon to your launcher. Super+d also does that.

Q: I have little freezes in Ubuntu. Most notably, when playing music, it will just freeze for a few seconds, then continue without giving an error. I have run a fsck on my drive twice, and installed proprietary drives, to no avail. The only thing I see is the time out: "Timed out waiting for device dev-disk-by wwwwwwwwwwwwwwwwww". Sometimes my mouse won’t even move and sometimes only my mouse moves. I have a Dell Optiplex 770 with a 250GB Seagate drive and 4GB of RAM with a Geforce 210.

A: Even though fsck reports no errors, what is happening is that the drive is struggling to read the platters. You have two options: you can back up your data and do a low level format (this may take all day and not fix your problem), or you can replace the drive and be on your way. Some people swear by Spinrite, a commercial program to low level format your disk. I tried it once with a small disk - 80 GB I think it was - and it ran all day and night, so I am not sure how long it will run on 250 GB. You can also try the low level utility from Seagate.

Q: I cannot get my mouse pointer to sync. Is there a way to calibrate it? It keeps missing my window by a mile. I have looked for the synaptic utility, but I didn’t find it. I have a custom mouse pointer theme installed, but even if I uninstall the theme and use stock pointers, dmz-black or dmz-white, it still does it. It is frustrating when you have windows tiled against each other. You cannot tell where one ends and one begins.

A: What you are describing is the same issue I have. I suspect you have vanilla Ubuntu 18.04 installed. However, I have this issue only when windows are over each other or next to each other, not single use. I can suggest installing only an Ubuntu "flavour" by Canonical that does not fire up Gnome. Ubuntu Mate is a very popular option. There are tutorials on installing "vanilla" Gnome on the internet as another option.

Q: I have an HP 14-AN001NA laptop. I’ve installed Ubuntu 18.04 in dual-boot, but it is not showing any wifi which is in the next room. In Windows, it is showing all networks and connecting full bars. lspci says its a realtek RTL8723BE PCIe.

A: The notebook laptops have two pigtails coming from the wireless modules. Generally they go via the hinges to the screen and around the outer edges. One is the primary and one is secondary.
Q: My Ubuntu was upgraded from 16.04 to 18.04 with no issues. However, my startup times and shutdown times are longer. My startup applications are: 1. anydesk tray, 2. komorebi, 3. MPD, 4. Safe Eyes, 5. Snap user application autostart helper, 6. SSH key agent.

I have not used snaps before, so I think it could be snaps. The df command brings up too many snaps to list. What am I doing wrong?

A: Run the command: ‘systemd-analyze blame’ and look at the output. Nine times out of ten, your computer is waiting for something from the network (test this by turning off WiFi and unplugging the network cable when booting). Also try the command: ‘systemd-analyze critical-chain’. This should highlight the waiting ones in red. You can also look at a program called bootchart.

Q: I recently got a new router from my ISP that has 5 GHz WiFi, but my potato laptop does not see the 5 GHz SSID. Is it Ubuntu or my dell latitude e4300? It runs Ubuntu minimal install and has 2 GB of memory with intel display.

A: According to the Intel product brief, the Intel card does support 5 GHz. A quick trawl on the internet show that that functionality is not on by default, 802.11b/g is default, and you need it switched to a/b/g. I am afraid I don’t know how to accomplish this in Linux, but you can switch it with the Intel utility in Windows if you dual-boot.

Q: I am trying to add Midnight Commander, but I get the error: Reading package lists... Done Building dependency tree Reading state information... Done Package mc is not available, but is referred to by another package. This may mean that the package is missing, has been obsoleted, or is available only from another source.

A: Install synaptic package manager. Go to settings, repositories, and make sure the top 4 checkboxes are ticked. If not, it will reload the package repositories. Now go back to the main window and search for mc in name only. Mark it for installation, and it should mark the dependencies. Now click on apply. If you use a GUI, there is sunflower, double commander, mucommander, etc.

Q: After upgrading from 17.10 to 18.04, I get screen tearing when I run a movie in SM Player as well as VLC. In MKV format and MP4 and AVI format. I have a core2duo with nvidia gfx and 4 gig memory. CPU usage is high, but not too high, and memory usage is 80%. Temperatures are med-high.

A: Remove (purge) your nvidia driver and reinstall either 3.04 for older cards or 3.90 for newer cards.

```
sudo apt-get remove --purge nvidia-`
```

Erik has been in IT for 30+ years. He has seen technology come and go. From repairing washing machine sized hard drives with multimeters and oscilloscopes, laying cable, to scaling 3G towers, he’s done it.
Having had Steam surprise us last month with SteamPlay, I figured that, for this month, it would be best suited if we put our money where our mouth is. So, having a brand new plethora of games from which to choose, I selected a game recently made available on Linux – thanks to SteamPlay. With Tekken 7 on sale, it was an easy choice for me (regular price is $49.99 through the Steam Store) so I bought it, downloaded, and installed it. To my pleasant surprise, Tekken 7 plays really well on Linux.

Tekken 7 is a fighting game (think Mortal Kombat, Street Fighter, etc). This is actually not the seventh, but rather the ninth game in the Tekken series. Tekken 7 was originally released as an arcade game in Japan back in spring 2015. Eventually, in June 2017, the game was released for PlayStation 4, Xbox One & Microsoft Windows. As of August 2018, thanks to Valve’s SteamPlay, Tekken 7 is now available for Linux.

Installation for this game via SteamPlay was a breeze. There were no extra steps needed. Just install the game as I would install any other Steam game. One recommendation AND precaution that I would add is to look through the SteamPlay Compatibility Report. One of the main reasons I decided to go with Tekken as the first SteamPlay game I review was because of the high rating it received on the SteamPlay Compatibility Report. At the time, the rating was Gold (only Platinum is higher) but it has since been downgraded to Silver (which is still pretty good). Having installed the game, there was still the doubt as to how it would play, especially because it took a little too long to load the first time but I suppose that’s to be expected. I can now launch the game and actually begin fighting within a couple of minutes (there are still cinematic cut-scenes that need to be manually skipped by pressing a button), which is what is to be expected from most fighting games.

Tekken 7 can best be played with a game-controller but you can also use mouse/keyboard. Like most fighting games, there are basic moves you can perform and then there are more complicated moves that require a combination of buttons to be pressed in precisely the right order. Anyone who’s ever played a fighting game in the past will be able to adjust to Tekken 7 just fine. Having done most of my playing with a game-controller, I can attest that Tekken 7’s controls are very responsive and smooth. Every movement my character made was carefully crafted by the previous combination of buttons I had just pressed on the controller.

The graphics on this game are pretty awesome, both during the actual fighting as well as in the cut-scenes. In fact, out of all fighting games I’ve played on Linux, I’d say this one has perhaps the best graphics, best sound, best voice-acting, and it’s also very creative in how it deals with various attack-moves & combos. One of the cool things about this game is that it can be enjoyed as a 1-player game, multi-player (locally), or online-multi-player, and the experience is...
nearly the same. In other words, all three of those formats I mentioned are just as exciting with Tekken 7.

There are two ways to play a 1-player game; the first is to play the Story Mode while the second way is to play Offline (which is Story Mode minus the story). For those who enjoy Online matches, you’ll be pleased that there are a couple of different choices for online playing. For example, you can play just for fun, or you can play and be ranked. If you’re being ranked, that means that the game servers are keeping track of your performances and are ranking you so that you’re paired up with players at more or less your level. Then, if you’re daring, and ranked play is getting too boring for you, there is an Online Tournament Mode that you can play which basically explains itself.

All in all, I really like playing this game. As I stated earlier, I would probably have to say that this is the best Linux fighting game I’ve ever played. As seen in the SteamPlay Compatibility Report, not everyone has enjoyed this game as much as I have; and indeed I did encounter a minor bug (but then again, can we call it a bug being that the developers never intended for this game to be played on Linux?) which was that every single time I would stop playing the game, then it would get stuck at “Syncing”, and the only way to fix this was to restart Steam (so a bit of an inconvenience). Other than that, I encountered no other problems (as long as resource-hungry Chrome is not running in the background).

Minimum Requirements:
- 64-bit CPU
- OS: Windows 7/8/10 (Linux under Steam-Play)
- CPU: Intel core i3-4160 @ 3.60GHz or better
- RAM: 6 GB
- GPU: Nvidia GeForce GTX 660 2 GB, GTX 750Ti 2 GB or better
- Network: Broadband Internet Connection

Oscar graduated from CSUN, is a musician, game enthusiast and has been working with Bitcoin and other alt-coins. You can follow him at: https://twitter.com/resonant7band or email him at: 7blueband@gmail.com
The current site was created thanks to Lucas Westermann (Mr. Command & Conquer) who took on the task of completely rebuilding the site, and scripts, from scratch, in his own time.

The Patreon page is to help pay the domain and hosting fees. The yearly target was quickly reached thanks to those listed on this page. The money also helps with the new mailing list that I set up.

Several people have asked for a PayPal (single donation) option, so I’ve added a button to the right side of the website.

A big thank you to all those who’ve used Patreon and the PayPal button. It’s a HUGE help.

https://www.patreon.com/fullcirellemagazine

https://paypal.me/ronniertucker

https://donorbox.org/recurring-monthly-donation
FULL CIRCLE NEEDS YOU!
A magazine isn’t a magazine without articles and Full Circle is no exception. We need your opinions, desktops, stories, how-to's, reviews, and anything else you want to tell your fellow *buntu users. Send your articles to: articles@fullcirclemagazine.org

We are always looking for new articles to include in Full Circle. For help and advice please see the Official Full Circle Style Guide: http://bit.ly/fcmwriting

Send your comments or Linux experiences to: letters@fullcirclemagazine.org
Hardware/software reviews should be sent to: reviews@fullcirclemagazine.org
Questions for Q&A should go to: reviews@fullcirclemagazine.org
Desktop screens should be emailed to: misc@fullcirclemagazine.org
... or you can visit our site via: fullcirclemagazine.org

For the Full Circle Weekly News:
You can keep up to date with the Weekly News using the RSS feed: http://fullcirclemagazine.org/feed/podcast

Or, if you're out and about, you can get the Weekly News via Stitcher Radio (Android/iOS/web): http://www.stitcher.com/s?fid=85347&refid=stpr

and via TuneIn at: http://tunein.com/radio/Full-Circle-Weekly-News-p855064/

FCM#139

Full Circle Team
Editor - Ronnie Tucker
ronnie@fullcirclemagazine.org

Webmaster - Lucas Westermann
admin@fullcirclemagazine.org

Editing & Proofreading
Mike Kennedy, Gord Campbell, Robert Orsino, Josh Hertel, Bert Jerred, Jim Dyer and Emily Gonyer

Our thanks go to Canonical, the many translation teams around the world and Thorsten Wilms for the FCM logo.

Getting Full Circle Magazine:

EPUB Format - Most editions have a link to the epub file on that issue's download page. If you have any problems with the epub file, email: mobile@fullcirclemagazine.org

Issuu - You can read Full Circle online via Issuu: http://issuu.com/fullcirclemagazine. Please share and rate FCM as it helps to spread the word about FCM and Ubuntu.

Magzter - You can also read Full Circle online via Magzter: http://www.magzter.com/publishers/Full-Circle. Please share and rate FCM as it helps to spread the word about FCM and Ubuntu Linux.